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Audio Box is an all in one recording studio and sound creation tool for your 
Pocket PC, ideal for creating your own musical compositions without the need for 
dedicated hardware. Inspiration doesn’t always strike whilst sat at your PC, so if 
you’re a musician looking for a quick way to lay down your ideas or want to 
create complete compositions then this is the only package you need.  
 
The Pocket PC alone does not have the ability to play standard MIDI files.  This 
is because it lacks the necessary hardware support in the form of Wavetable 
synthesis necessary to achieve this. This means that at best you are limited to 
playing simple WAV and MP3 files.  Audio Box solves this problem by allowing 
you to create your own virtual instruments which are fully configurable. Audio Box 
allows you to emulate the sound of classic synthesisers which became 
widespread in the 80’s and are still at the heart of modern music today. 
Customise the sounds to match your style of music or use the presets, it’s up to 
you! Audio Box also comprises a digital sampler, a dedicated multitimbral string 
pad synthesizer and a drum machine allowing you to create your own 
customised drum kits.  
 
Of course having the ability to generate sound is not everything… Audio Box is a 
complete music composition package with both track and score editing.  The 
interface is simple to use, and yet provides a comprehensive range of features..  
 
Audio Box allows you to create up to separate 16 tracks, each track assigned it’s 
own instrument. An integrated mixing desk allows you to control the overall mix 
as well as assign multiple effects to each channels.  
 
Audio Box also features the ability to automate instruments, effects and the mixer 
using custom controller messages sent from the sequencer. 
 
Audio Box has the ability to work in high quality 44Khz mode or  22Khz mode for 
some slower models of Pocket PC. The polyphony and number of effects are 
only limited by the speed of your Pocket PC, so there is nothing to hold you back! 
 
 
 
 



Hardware Keys 
 
The four hardware buttons on your Pocket PC are assigned various functions 
which are required in order to use Audio Box. The location of these buttons may 
alter from one model of Pocket PC to another. 
 

                    
 
 
 
 
1) The EXIT button allows you to exit Audio Box. 
 
2) The LISTEN button is used to hear a note from the voice assigned to the 
active track. You can use this key to monitor the changes made whilst editing 
sounds. The note produced is A-440Hz. 
 
3) The OPTIONS button displays a menu of various program options which can 
be enabled or disabled. These options are as follows: 
 

Follow Song: When turned on will ensure that the screen scrolls to keep up 
with playback of your song. Turn this off when you wish to edit your song with 
loop points set to stop the screen scrolling. 
 
Loop Mode: Turns on loop mode. When enabled this causes playback of a 
specified range of your song to be continuously repeated until you press 
‘Stop’.. This mode is used in conjunction with loop start and loop end markers 
which are discussed elsewhere in this manual. 
 
Solo Track:  Toggles solo mode on/off for the selected track. Solo mode 
disables the output of all other tracks except that of the selected track. Use 
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this to listen to the selected track in isolation. It is often useful to place a track 
in solo mode when adjusting effects or setting up instruments. 
 
Mute Track: Toggles mute mode on/off for the selected track. When a track 
is in mute mode it does not output any sound. This is useful when mixing or 
listening to selective tracks. 
 
Metronome: Toggles the metronome on/off. You can control the metronome 
volume from the Preferences window. 

 
4) The EDIT button displays a menu of options associated with score editing. 
These options are discussed in the score editing section of the manual. 
 
The Direction Pad  
 
The direction pad can also be used during editing and has the same functionality 
as the scroll bars (in track and score modes).  The ‘START’ button located in the 
centre of the direction pad can be used to start and stop playback. This is handy 
on screens where the transport bar isn’t available. 



The interface 
 
Audio Box has a tab system to move between various sections of the program. 
There are five main areas to the program which are accessible from the tab bar 
at the bottom of the screen.  
 

1) Track editor. 
2) Score editor. 
3) Voice / Instrument assignment. 
4) Mixer settings. 
5) File / Preferences. 

 
 

 
 
The Information Bar 
 
The information bar appears at the top of the screen in both score and track 
modes and displays information that is relevant to your composition. 
 

 
 
At the very left of the information bar is the song position counter. This gives you 
an accurate reading of the position of the play cursor within your song. As the 
song is played this with change to reflect the current bar, beat and 1/8 beat of the 
cursor. 
 
The next option is the ‘Note/Duration Length’. Tapping the screen over this value 
displays a popup menu with various fractional bar values. By default this is set to 

Selected 
Track. 

Track 
Numbers. 

Five main 
program 
area tabs. 

Information 
Bar 

Transport 
Bar. 

Mute 
Checkbox 

Solo 
Checkbox 



¼ bar. The way this value is interpreted depends on what you are doing. If you 
are adding notes in score mode then this refers to the note length of newly 
created notes. If you are in track mode this refers to the note grouping size used 
to display track data. This is also used as a snap value when dragging notes and 
blocks of data. 
 
The tempo comes next and as default is set to 140bpm. This can be changed by 
tapping on the display and selecting a preset value from the popup menu or 
picking the ‘User Defined’ option to specify a custom value. 
 
The time signature comes next. By default it is set to 4/4 which is standard for 
most compositions.  
 
And finally the active track number. Tapping the stylus on this item displays a 
menu of tracks from which you can select the active track. You can also change 
the active track using the UP and DOWN direction keys. 
 
The Transport Bar 
 
The transport bar is used to navigate your way around your composition and the 
way to start and stop playback. 
 

 
 
The buttons are as follows from left to right:- 
 

1) Loop Mode. 
2) Go to start of song. 
3) Rewind. 
4) Stop. 
5) Pause. 
6) Play. 
7) Fast Forward. 
8) Go to end of song. 

 
Most of these are pretty self explanatory except for Loop Mode. Normally when 
you press the play button the song plays from the current cursor position, only 
stopping when you hit the end of the song. Loop mode works in conjunction with 
a set of loop points which specify an area of the song which is to be played in a 
continuous loop. This is very handy for song construction as you can lay notes 
whilst a song is playing.  
 
 



 

The Track Editor 
 
When you first run Audio Box you will be presented with an empty project and the 
program will default to track editor mode. This screen shows an overview of all 
individual tracks on a single screen and is where you select the track you wish to 
work with. Tapping your stylus on the track number makes that track the currently 
selected track. The RED rectangle surrounding a track denotes the currently 
selected track. You can also use the UP and DOWN keys on the direction pad to 
move between tracks. In track and score modes the current track number is also 
displayed in the top right of the information  bar. 
 
Audio Box allows you to use up to 16 tracks, but only 12 are viewable on screen 
at any one time. Use the vertical scroll bar or the UP / DOWN keys to scroll the 
display. 
 
The Timeline appears beneath the information and transport bars, and is 
available in both track and score modes. This gives you an accurate position of 
where the on screen data appears within your song. When in play mode the 
playback cursor will appear on as a vertical red line which will scroll along as 
your composition plays. The timeline can be used to read the play position within 
your composition. 
 
The track editor has some functions which are unique to this display mode which 
are as follows:- 
 
Mute: To the right of the track is the ‘Mute’ checkbox. Tapping this checkbox 
toggles mute mode for the selected track.  When a track is in mute mode it does 
not output any sound. This is useful when mixing or listening to selective tracks. 
 
Solo: Next to the ‘Mute’ button is the ‘Solo’ button. This is used when you need 
to hear a single track in isolation. It is often useful to place a track in solo mode 
when adjusting effects so you can clearly hear parameter changes or effects. 
 
Track mode is simply a convenient way of displaying an overview of the musical 
score, but can also be used for duplicating and moving sections of your 
composition. Notes are grouped into chunks for easy manipulation. You can 
change the size of the chunks by modifying the ‘Note Length’ property by clicking 
on the Information bar as follows:- 



 
 
 

 
 
Moving and Copying  
 
You can easily move and copy chunks of your song from one bar location to 
another in track mode using cut, copy and paste. Simply click on a chunk to 
select it, when selected the chunk will turn blue. You can also drag a rectangle 
around a group of chunks using your stylus. As previously mentioned the size of 
the chunks is determined by the ‘Note Length’ menu.  It is often handy to change 
this setting to ‘Bar’ in order to select bar length chunks of notes.   
 
Once you have selected a group of chunks they can be moved by tapping and 
holding a selected chunk and dragging the stylus across the screen. This drag 
method is useful for moving data from one track to another or for moving sections 
of your composition from one location to another.  
 
If you need to move sections over several bars it may be easier to cut and paste 
the data into a new location. To do this press the EDIT menu button and select 
CUT from the menu. Now use the horizontal scroll bar or the LEFT and RIGHT 
direction keys to move to the area you wish to paste the data. Tap the stylus in 
the time-bar at the bar location you wish to paste the data. The location cursor 
should appear at this location (i.e. a vertical red line is displayed). Now simply 
press the EDIT menu and select PASTE. You should now see the copied data 
moved to the new location. You should also notice the location cursor advance 
past the pasted data ready for you to paste again if required.  
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There are a few rules governing the way data is copied in track mode which you 
should be aware of: 
 

1) If you cut or copy data from a single track then you can select a target 
track and set the location cursor before paste.  

2) If you select data from several tracks then you can only set the location 
cursor. In this instance is not possible to select a target track. Whenever 
you copy multiple tracks, this data will always be pasted to the track It was 
copied from. 

 
The Edit Menu 
 
The EDIT menu is available in both track and score editing modes and is 
accessed by pressing the EDIT key on your Pocket PC.  
 

 
 

The EDIT menu contains the standard cut, copy and paste selection tools as well 
as a number of other features which are described below. 
 
Zoom: This option allows you to zoom in and out of the display. The default 
zoom level is 3 but you can select higher values to zoom in and lower values to 
zoom out. This is very useful when you have the Note Length setting at 1/16 and 
1/32. 
 
Loop Start: Sets the start of a loop point. You can tell Audio Box to play a 
certain section of your song in a repeated loop fashion. To do this you need to 
set a start and end point for your loop and turn on loop mode from the navigation 
bar. 
 



Loop End: Sets the end of a loop point. 
 
Song Finish: The playback of your song ends when the location cursor reaches 
the Finish marker. This appears on the timeline as a black square containing the 
letter ‘F’. This option sets the Song Finish point to that of the location cursor. Tap 
the stylus in the timeline to move the location cursor. You can also click and drag 
the finish marker to alter the song length. 
 
Track Name: You can specify a text label for each of the 16 tracks which can be 
used as a reminder as to the contents of each track.  You can toggle the printing 
of track names to screen in the Audio Box preferences screen. 
 
Delete Controllers: Deletes all controllers on the specified selected track.  
Controllers are an advanced topic covered later in this manual. 
 
Quantize Song: This option should is only necessary after importing midi files 
because notes are automatically quantised by Audio Box in the score editor.  
This option automatically fixes problems associated with real time input of midi 
data such as timing problems. This function moves note on times so that they fall 
on the nearest beat boundary, specified by the ‘Note Length’ property. This fixes 
errors with notes that are slightly out of time. You should select 1/16 or 1/32 note 
lengths before running the quantise function.  
 



The Score Editor 
 
The score editor is essentially where you lay notes on a specified track. You can 
manipulate note length and velocity as well as controllers such as pitch bend and 
aftertouch. You can select the active track from the track menu by tapping the 
track number in the Information bar. This displays a menu allowing you to select 
the track. Alternatively you can use the UP and DOWN arrow keys to move 
between tracks. 
 
 

 
 
 
Adding Notes 

 
To add a note onto the notation grid you need to first select the ‘Note Length’ 
from the menu (By default this is set to 1/4 bar). Next you need to ensure you 
have the Pen tool selected from the ‘Edit Tools’ menu. Now simply tap your pen 
at the desired location that corresponds to the note on the piano roll using the 
timeline as a guide.  
 
TIP: If you press the stylus on the screen the note will appear. Keeping the stylus 
pressed against the screen you can then drag the note to the desired location. 
Finally lift the stylus to confirm the position. 
 
Moving Notes 
 
To move notes you first need to select the move tool from the ‘Edit Tools’ menu 
(The move tool is the arrow pointer icon).  Now simply tap on a note and with the 
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stylus down drag the note to its new location. When you tap a note it becomes 
selected. You should also notice selected notes appear in blue. You can select 
as many notes as you like before performing the move operation and can even 
do so by dragging a rectangle around the group notes.  
 

 

 
 
 
Changing a Notes Duration 
 
You will also notice that selected notes have a square box to the right of the note 
which are to allow you to change the duration of the note. If you tap this box and 
drag the to the right you will increase the note duration. If you drag the box to the 
left you decrease the note duration.  
 
Changing Note Volumes 
 
Once you have added some notes to the score editor you will notice their 
respective volumes appear at the bottom of the display in the form of vertical 
bars. The longer the bar length, the louder the volume. To change the volume 
you first need to select the ‘Pen’ tool from the ‘Edit Tools’ menu. Now simply drag 
your pen over the volume area to raise or lower the volume. Using this method 
allows you to change the volume of many notes at the same time. 
 
The Piano Roll 
 
At times you may wish to hear a note before you add it to the score. To do this 
tap the piano roll at the desired note. You should now hear an audible note 
sound at the requested pitch. The selected note, octave and midi note will also 
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be displayed on screen in a small window for reference. You must have selected 
a voice for that track before you can use this function.  
 
Loop Points 
 
Whilst creating your masterpiece it is often helpful to have a few bars of your 
score loop continuously whilst you add and remove notes or manipulate 
instrument settings. To set a loop you need to specify start and end points for the 
loop. You can do this using one of two methods.  
 
If you wish to loop just a couple of bars then the easiest method is to simply click 
in the timeline and drag from one time to another. Alternatively you can click in 
the timeline to set the play cursor, press the ‘Edit’ menu button, then select ‘Loop 
Start’.  Simply repeat the process to set the ‘Loop End’. Once a loop point has 
been set you should see the timeline change colour as in the following diagram. 
Two small arrows appear on the timeline designating the start and end points of 
the loop. You can select and drag these points to new locations if you wish. 
 

 
 
Finally to make Audio Box cycle between your loop markers press the ‘Loop 
Mode’ button on the transport bar. Now when you press play, the program will 
loop between the points specified until you press stop or turn off loop mode. 
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Voice Selection 
 

In order for any sound to be output you must select an device / instrument for 
each track you are using.  Select the track you wish to assign the instrument from 
the track editor then press the ‘Voice’ tab. This displays the following dialog: 
 
You should see a set of sub-tabs appear with 
‘Device’ being the active tab. This screen 
allows you to choose the device type to 
assign that channel, in this case channel 01.  
 
Classic Synthesizer: This option assigns a 
mono/polyphonic synthesizer to the selected 
channel. You then have complete control 
over the various synthesizer options using 
the Page1-4 buttons. This  
 
Pad Synthesizer: Assigns the string pad  
synthesizer to the selected channel. This is a 
special additive type synthesis especially for 
polyphonic sounds like strings, organs, bells 
and choirs.  
 
Sampler: Assigns a digital sampler to the 
selected channel. A sampler is an electronic musical instrument that allows you 
to take existing recordings and sounds and play them back at a range of pitches. 
You can use the sampler to simply trigger sounds via notes in the score editor 
(such as drum loop samples) or pitch shift samples to sound like real 
instruments. 
 
Drum Machine: Assigns the drum machine to the selected channel. A drum 
machine is a collection of up to 12 drum sounds that can be tuned and assigned 
to each of the 12 keys of a an octave. 
 
Tip: Once a voice has been assigned to a channel you can play a sample note 
by pressing the LISTEN key on your Pocket PC. 



The Classic Synthesizer 
 

The classic analog synthesizer was developed as far back as the 1920’s by 
Robert Moog, but it wasn’t until the 1970’s when the first Mini-Moog portable 
synthesizer became widely available. Since then the synthesizer has become 
standard issue in most recording studios and are enjoying renewed popularity 
today. Indeed, analog devices of all types might be more numerous now than 
they were during their heyday. At the dawn of the 21st century, there is still a 
steady demand for the technologies of yesteryear. 

Most early synthesizers were monophonic and could only play a single note at a 
time. Only in recent years has this changed, and most modern keyboards are at 
least 32 note polyphonic and have velocity sensitive keyboards. 

These days new forms of digital synthesis such as FM, PWM and Wavetable are 
used to create more life like sounds, but the original synthesis methods still 
remain as popular because of their unique synthetic sounds. 

A synthesizer works by electronically generating and mixing two or more simple 
waveforms to create a more complex and pleasing sound.  

The Synthesizer module in Audio Box is a very flexible tool, capable of creating 
all the classic synthesizer sounds, with the added benefit of being polyphonic and 
velocity sensitive.  Audio Box’s synthesizers also supports a number of features 
such as aftertouch and pitch bend that can be controlled via special controller 
messages sent via the score editor.  

Using the Synthesizer  
 
To assign a synthesizer to a track you must first select the track you wish to 
assign the instrument from the Track editor. Click on the track number to active 
the required track then tap the Voice tab.  A set of sub-tabs appears and the first 
tab ‘Device’ should be selected.  Now simply select ‘Synthesizer’ from the list of 
devices. You have now assigned a synthesizer to the active track. 
 
Patch Selection 
 
Once a synthesizer has been assigned to a track, you can load existing patches 
or easily make up your own sounds. When Voice is selected from the main tab 
bar a sub-set of tabs is displayed. The first being the device selection screen 
(which should be set to Synthesizer). The second tab is where you can load and 
save patches. A patch is simply a name given to a file which contains the settings 
that create a sound.  
 



 

 
 
Tip: Once a voice has been assigned to a channel you can play a sample note 
by pressing the LISTEN key on your Pocket PC. 
 
Now you have loaded a patch you can modify the parameters and customise the 
sound to your own requirements using the Page 1-4 tabs. 
 
Editing and Creating Patches 
 
When you first assign a synthesizer to a track, the synthesizer inherits default 
settings, which can be modified and can be saved to create your own patches. It 
is often easier to load a patch that sounds close to the sound you are looking for 
then make minor adjustments.   
 
Analogue synthesis is essentially a four stage process, tone generation, tone 
shaping, volume shaping and finally sound modulation. Each stage generally has 
it’s own set of parameters that work in conjunction with one another. The tabs 
labelled Page 1-4 allow you to configure various parameters. 

 
 

 
 



VCO 
Voltage Controlled Oscillator 

 
At the heart of every synthesizer is 
the VCO. This is where sound 
creation begins and is responsible for 
the overall timber and tuning of the 
sound. The synthesizer in Audio Box 
uses two separate sound sources, 
often referred to as oscillators to 
generate a sound.  
 
Each oscillator has it’s own settings, 
allowing you to select the wave type 
as well as the pitch and amplitude of 
the sound.  
 
There are four different types of 
waveform you can select, each with 
it’s own unique sound.  The sine 
wave is the most basic of waves and 
contains no harmonics. The sine 
wave produces a dull pure tone 
which is not so audible at low 
frequencies. The triangle save is 
similar to the sine wave but has a 
little brighter sound as a result of the 
small number of harmonics.  

 
The square wave is made up of an 
odd number of harmonics and 
produces hollow sounds. 
 
Saw waves are very rich in 
harmonics and have a brassy bright 
sound useful for strings or deep bass 
like sounds. This is probably one of 
the most widely used wave types and 
often produces the most pleasing 
sounds. 
 
 
 
 
 
 

 
 
 

Sine Wave 
 
 

Square Wave 



By using a mix of these basic tones 
you can create many unique sounds. 
Use the ‘Level’ option on each 
oscillator to control the mix of each 
wave. 
 
There is a third wave generator 
which we haven’t mentioned, and 
that is the white noise generator. This 
is a mixture of many different 
frequencies and is often used to 
emulate noises such as wind, sea or 
breath that don’t have a fixed pitch. 
You can control the mix of noise 
using the ‘Noise Level’ knob. This 
sound source is most useful when 
both oscillators are turned off. 
 
Each oscillator has three tuning 
knobs which let you set the basic 
pitch of the output.  The note 
information from the sequencer is 
added to the basic pitch to create 
notes. 

Saw Wave 
 
 

White Noise 

 
The pitch controls are as follows: 
 
Octave: Allows you to transpose the oscillator up or down by 3 octaves. An 
octave is the span from say the ‘A-440Hz’  on a piano to the next ‘A’ at 880Hz.  
 
Semitone: Allows you to transpose the oscillator by a single note value. You can 
transpose up and down by a total of 11 semitones. 
 
Detune: Enables you to finely tune the oscillators by a fraction of a semitone. 
This is useful for detuning oscillators to give a chorus like effect.  
 
Tip: Audio Box is a detune option in the Preferences which allows you to tune 
the overall output of the program as opposed to a single instrument of oscillator. 
 
 



 
ADSR 

Attack, Decay, Sustain, Release 
 
The ADSR settings control the shape 
of the sound in terms of the way the 
amplitude or loudness changes over 
time. These settings allow you to 
imitate real musical instruments such 
as the piano that has a sharp attack 
and a long sustain after releasing the 
note. 

The ADSR envelope is specified using 
the following four parameters: 

• Attack: How quickly the sound 
reaches full volume after the sound is 
activated (the key is pressed). For 
most mechanical instruments, this 
period is virtually instantaneous. 
However, some for some popular 
synthesized "voices" that don't mimic 
real instruments, this parameter is 
slowed down. 

• Decay: How quickly the sound 
reduces in volume after the initial 
peak.  

• Sustain: The "constant" volume that 
the sound takes after decay until the 
note is released. Note that this 
parameter specifies a volume level 
rather than a time period 

• Release: How quickly the sound 
fades after the end of the note (the 
key is released). Often, this time is 
very short. An example where the 
release is longer might be a 
percussion instrument like a piano 
with the sustain pedal pressed.  

 
 

VCF 
Voltage Control Filter 

 
The VCF is a device used to filter out 
unwanted overtones and leave only the 
wanted frequencies of the sound.  
 
The ‘Cutoff’ frequency allows you to 
alter the tone colours by boosting or 
cutting harmonics in the signal sent 
from the VCO.  
 
Changing the ‘Resonance’ accents 
frequencies at the cut-off frequency. Be 
careful not to turn this option up too 
high as it is possible to create feedback 
at certain cut-off frequencies. 
 
The VCF also has an envelope which 
works in a similar way to that of the 
VCO only here we are modifying the 
filters cut-off frequency and not the 
velocity of the notes. 
 

 



 
LFO 

Low Frequency Oscillator 
 

The LFO is used to add such things as 
vibrato, tremolo and wah-wah to the 
final output. At the heart of the LFO is 
another oscillator, that can be set to a 
given frequency using the ‘Speed’ 
knob. The output of this oscillator can 
then be fed into the VCO to produce 
Vibrato, the ADSR to produce tremolo, 
or the VCF to produce a wah-wah 
effect. 
 

 
 
The low frequency oscillator can have 
one of 4 wave types, three of which we 
have seen before. Random is a new 
type which simply uses contently 
changing random numbers. This is 
great in conjunction with the wah-wah 
for producing wobbly bass like sounds. 
 
The Attack controls how quickly the 
effect is faded in. If this is set to 0 then 
the effect will be instantaneous.  

FM Modulation 
 

Frequency modulation is a method of 
creating more interesting forms of 
sound from the VCO. Enabling this 
option allows you to modulate the 
VCO’s oscillators using another signal. 
Altering the Octave and Level allow 
you to create very aggressive and hard 
noises. 
 

 
 

Keyboard 
 

The keyboard settings allow you to 
control the way in which notes are 
manipulated and have nothing to do 
with the sound production itself.  
 
Portamento: Allows you to glide from 
one note to another. The higher the 
setting the slower the glide. A value of 
0 turns off this feature. 
 
Bend: Specifies the pitch bend range 
used by the sequencer.. 
 

 



Tip: The VCF and LFO are very processor intensive and so you can reduce CPU 
usage by turning these options off.  By default the synthesizer is set to 
monophonic mode. You can turn off mono mode, but bare in mind this may put a 
load on the CPU if too many notes are played at once. 
 



The Sampler 
 
The sampler is an instrument which allows you to manipulate previously recorded 
sounds. You can use the patches provided or use your own using samples 
you’ve recorded yourself or downloaded from various sources available on the 
internet. 
 
Using the Sampler 
 
To assign a sampler to a track you 
must first select the track you wish to 
assign the instrument too from the 
Track Editor. Click on the track number 
to active the required track then tap the 
Voice tab.   
 
A set of sub-tabs appears and the first 
tab ‘Device’ should be selected.  Now 
simply select ‘Sampler’ from the list of 
devices. You have now assigned a 
sampler to the active track. 
 
The four tabs Page 1 to 4 can now be 
used to configure the sampler. Most of 
the settings are similar to that of the 
Synthesizer except for the first page. 

 
 

Patch Selection 
 
Once a Sampler has been assigned to a track, you can load existing patches or 
load your own WAV files to create your own patches. When Voice is selected 
from the main tab bar a sub-set of tabs is displayed. The first being the device 
selection screen. (which should be set to Sampler). The second tab is where you 
can load and save patches. A patch is simply a name given to a file which 
contains the settings that emulate an instrument.  To load a patch tap the stylus 
on the patch you wish to load and press the load button. 
 
Creating Patches 
 
You can create your own patches by importing external WAV files from your 
Pocket PC. To do this simply click the Load button and select the sample. Once 
the sample is loaded it should appear in the sample graph window. You can 
press the Play button at any time to listen to the sample played at A-440Hz.  You 
should now tune the sample and set any loop points if required. 



Tuning Samples 
 
Once a sample has been loaded, you will generally want to tune it. A few 
exceptions to this are vocals, drum loops and sound effects. Ideally you need to 
tune the sound so that the LISTEN key produces a note whose frequency is as 
close to A-440Hz as possible.  You can either do this manually using the Octave, 
Semitone and Detune knobs or let the Auto Tune function do it for you by simply 
pressing the Auto Tune button. This is not always successful and may fail if you 
attempt to tune certain sounds like drums, percussion or vocals. The auto-tune 
function can also fail if there is excessive harmonic content in the sound. 
 
Loop Points 
 
Some of the default Audio Box Sampler patches are very small in size, and yet 
are able to sustain notes indefinitely. This is done using small samples which are 
looped to create the impression of being much bigger.  
 
Pressing the ‘Loop’ button turns on loop mode. Once enabled you will notice two 
red vertical lines appear on the display, one called the loop start point and the 
other the loop end point. By default the loop start is placed at the beginning of the 
sample and the loop end at the end of a sample. When you press the LISTEN 
button on your Pocket PC the sample will play and loop until you release the 
button. You can move these loop points by tapping the stylus in the graph area. 
To move the start point you must ensure the start button is active. Likewise, to 
move the end point the end button must be active. 
 
When a note on is sent to the sampler, the sample begins playing from the 
beginning and proceeds until it hits the sample end point. Playback then moves 
to the start point and proceeds to cycle between the two points whilst the key is 
down. When the key is released the sample then plays to from it’s current 
location till the end of the sample. 
 
Setting loop points can be very frustrating and time consuming. Not all samples 
can be perfectly looped, and in many cases you may need a little help from the 
loop point locators. The ‘Previous’ and ‘Next’ loop point buttons will attempt to 
search for ideal loop point locations, matching velocity and phase of both loop 
points. You will need to select the ‘Start’ and ‘End’ buttons accordingly so that the 
‘Next’ and ‘Previous’ locator functions know which loop point you are moving. 



The Pad Synthesizer 
 
The Pad synthesizer is specially designed for creating strings ensamples, choirs, 
organs as well as bell and metallic type sounds. You should use this in 
preference to the classic synthesizer whenever possible if a track contains 
polyphonic data (i.e. plays multiple notes at 
the same time).  
 
The Pad synthesizer is capable of producing 
some really beautiful sounds which are just 
not possible with the classic analog 
synthesizer. It uses a technology called 
additive synthesis by which sounds are 
created by layering harmonics. 
 
Using the Pad Synthesizer 
 
To assign a pad synthesizer to a track you 
must first select the track you wish to assign 
the instrument too from the Track Editor. 
Click on the track number to active the 
required track then tap the Voice tab.   
 
A set of sub-tabs appears and the first tab 
‘Device’ should be selected.  Now simply select ‘Pad Synthesizer’ from the list of 
devices. You have now assigned a pad synthesizer to the active track. 
 
The four tabs Page 1 to 4 can now be used to configure the pad synthesizer. 
Most of the settings are similar to that of the classic synthesizer except for the 
first page. 
 
Creating sounds with this instrument is rather like painting by numbers. You don’t 
really need to understand how it works, although I will try and give a brief explain. 
 
All natural real world instruments produce sounds which are not so simple as 
those produced using the classic synthesizer. When you play A4 (440Hz) on a 
piano keyboard and analyse the sound produced, you will see that the 
fundamental frequency is 440Hz, but there are many overtones or harmonics that 
occur at 880Hz, 1760Hz and so on. The classic synthesizer cannot emulate 
these overtones which is why the sounds it creates are so synthetic. 
 
The Pad Synthesizer has 32 drawbars which correspond to 32 overtones or 
harmonics that can be added or subtracted from the fundamental frequency. The 
first drawbar is set by default as this is the root frequency of the note. You will 
notice the graphical display shows that of a sine wave. As you click on the 
various drawbars to add and subtract harmonics you will see this sine wave 



change.  You will notice that there is a brief pause whilst Audio Box computers 
the sound. Once this process is complete you can hear your sound by pressing 
the LISTEN button on your Pocket PC. 
 
Once you have the tonal quality you desire you can ‘beef it up’ by increasing the 
‘Bandwidth’ knob. This fattens out each of the harmonics as illustrated in the 
diagram below. Notice how the high end harmonics have merged together. This 
is a due to the frequency spectrum being non linear and will result in making the 
sound appear mushy, which is great for strings ensembles, but not so good for 
other sounds. 
 
The ‘Scale’ knob is used to control the bandwidth at high frequencies by 
compensating for the non linear frequency scale. A value of 0 ensures all 
harmonics have the same bandwidth, whilst a value of 1 gives the largest 
frequency spread. 
 

 
Pressing the ‘Reset’ button removes all but the fundamental frequency allowing 
you to start over again from a pure sine wave. 
 
Pressing the ‘Detune’ button causes the harmonics to drift slightly creating 
discordant metallic or bell like sounds.  
 
By default the pad synthesizer is set to polyphonic mode and should always be 
used in place of the classic synthesizer where possible as it is less CPU 
intensive. 
 
That’s all there is to it….  
 
NOTE: Please see the classic synthesizer section for information on 
configuration pages 2-4. 
 



Drum Machine 
 
The drum machine allows you to create your own drum kits using standard WAV 
files. You can have up to 12 samples in a drum kit, all of which can be 
independently tuned and normalised.  
 
To assign a drum machine to a track 
you must first select the required track 
you wish to assign the instrument to 
from the Track Editor. Click on the 
track number to active the required 
track then tap the Voice tab.   
 
A set of sub-tabs appears and the first 
tab ‘Device’ should be selected.  Now 
simply select ‘Drum Machine’ from the 
list of devices. You have now assigned 
a drum machine to the active track. 
 
Tabs ‘Page 1’ and ‘Page 2’ can now be 
used to configure the drum machine 
and tune your samples. 

 
 
Audio Box does not have a specific drum pattern editor as such, instead you lay 
notes in score view just as you would with any other instrument. All 12 notes of 
an octave can be assigned a unique drum sound.  If you assign a snare drum to 
‘A#’ you will hear a snare drum when playing A# regardless of the octave.  
 
Tip: You can tap the keys on the piano roll in the score editor if you need a 
reminder of which drums sounds are assigned to which keys. 
 
By default the gm.drumkit will be loaded. Pressing any of the keys labelled A to 
G# will play one of the 12 drum sounds.   
 
Assigning Samples to Keys 
 
To assign a new drum sound to a key simply press the ‘Set’ button which 
corresponds to the note you wish to re-assign. A standard browse dialog will now 
appear allowing you to select a WAV file. You can remove a sample by pressing 
the Clear button. This will reduce the size of the saved song if you have chosen 
to write out instrument patches. 
 



Tuning Your Drum Kit 
 
When creating a new drum kit you may find that some samples may appear 
louder or even out of tune when compared to others. You can fix this problem 
using the Pitch and Volume settings on Page 2 of the instrument settings.  
 

This screen shows the 12 notes which have 
samples loaded.  Notice that B and E don’t 
have the little triangle! This is because these 
notes do not have a sample assigned to 
them.  
 
By altering the left slider you can cut or boost 
the volume of the sound.  
 
By altering the right slider you can increase 
or decrease the pitch of the sample by one 
semitone. You can transpose the sound by 
as much as an octave in either direction. 
 
Pressing the buttons A-G# will allow you to 
listen to your changes. 
 
 

 
Suggested Drum Layout 
 
Although you are free to allocate any drum sounds to any note the following 
layout is recommended, especially if you are importing midi files. 
 
C      Bass Drum 
C#     Symbols 
D      Snare / High Tom 
D#     Ride Cymbal / Hand Clap 
E      Electric Snare 
F      Low Floor Tom 
F#     Closed Hi Hat / Tambourine 
G      Splash Cymbal / Floor Tom 
G#     Rim Shot / Cowbell 
A      Lo Tom 
A#     Open Hi Hat 
B      Acoustic Bass Drum



The Mixing Desk 
 
Audio Box is equipped with a 16 channel mixing desk which allows you to adjust 
the overall mix of the sound and add various effects to instruments. If you select 
the Mixer tab you will notice that a set of sub-tabs appear allowing you three 
options, current track, effects and all tracks. 
 
The ‘Current Track’ tab shows the 
mixer settings for the active track.  
 
This screen is where you adjust the 
volume and pan settings as well as 
being able to add effects.  
 
The ‘Mute’ button when pressed stops 
output from this channel. This is useful 
when you want to listen to your mix 
without this track. 
 
The ‘Solo’ button when pressed mutes 
all other tracks so you can listen to the 
selected track in isolation. This is very 
useful for setting up effects and 
instrument settings. 
 
The ‘Dry’ button simply bypasses the 
effects assigned to that channel. 

 

 
Assigning Effects 
 
You can have up to 3 effects per channel although care should be taken not to 
assign too many. The number of effects used in your song is restricted only by 
the speed of your Pocket PC, but they are very processor intensive and so it is 
advisable to keep these to a minimum. 
 
To assign an effect simply click the ‘Set’ button. A popup menu will appear with a 
list of available effects. Select the effect you wish to assign and you should see 
the ‘Enable‘ button activate and the effect name appear under the ‘Effect Level’ 
knob.  
 
Use the ‘Effect Level’ knob to adjust the amount of effect applied to the selected 
track. To clear an effect, press the ‘Clear’ button.  
 
Pressing the ‘Enable’ button will temporarily disable the effect.  
 



 

 
 

Pressing the ‘All Tracks’ tab displays 
the multi channel mixing console. This 
is a more conventional style mixer 
allowing you to visually monitor and 
adjust all tracks from a single screen. 
Only six channels are visible at any 
one time so you need to use the 
horizontal scroll bar to see channels 7-
16. There is also a ‘Master’ volume 
which allows you to adjust the final 
output to avoid clipping. 

 
Each mixer channel has it’s own 
volume and pan controls.  
 
You should ensure the LED’s do 
not peek in the red as this means 
the signal is being clipped and is 
likely to result in audible clicks or 
distortion. 
 

 

Pressing the ‘Effects’ tab allows you to 
modify the effect parameters assigned 
to the active track. 
 
Some effects are more processor 
intensive than others so bare this in 
mind. If you need to use lots of effects 
and the sound starts to break up then 
you need to consider removing effects 
or lowering the audio output from 
44Khz to 22Khz. This should allow you 
to get a reasonable quality output 
whilst having more effects active. 
 

 
 

Care should be taken to ensure the 
overall mix doesn’t cause excessive 
peaking of the VU meters. In general it 
is best to have the needle occasionally 
peaking into the red zone. If the needle 
is constantly in the red then the audio 
signal will be clipped and distortion or 
clicking will occur. 

 



Loading and Saving Songs 
 

Once you have completed your masterpiece you will want to save your work. You 
do this by pressing the ‘File’ tab and then selecting the ‘Save Song’ sub-tab. 
 

When you save a song you can save various 
settings and instruments as well as the 
musical score. This means that the saved 
song is almost like a package that contains 
everything needed to recreate your song and 
can be passed on to other Audio Box users. 
 
The save options are as follows: 
 
Mixer Settings: If this option is checked then 
all settings such as track volume and pan  for 
each channel are saved.  
 
Instrument Patches: This option saves all 
instrument settings and the samples used to 
create the sounds. This includes all drum 
machine and sampler sampled sounds. 
 

Effect Settings: Check this option to save effects you have assigned to various 
tracks and their settings.  
 
Save Controller Data: Allows controller data to be saved along with the score. 
This includes things such as pitch bend, aftertouch, automated mixer settings, 
and real-time instrument messages. 
 
Save: Actually saves the song. Pressing this button prompts you to name your 
song. Once the song is saved you will return to this screen. 
 
To load a previously saved song press the ‘File’ tab, then the ‘Load Song’ sub-
tab. A list of songs will appear from which to select. Tap the stylus on the file you 
wish to load and press the ‘Load’ button. Once loaded you will be taken to Track 
view ready to play the song. 
 



There are also a number of other buttons in 
this screen which have the following 
functionality. 
 
Delete: Deletes the selected song. On 
selecting this option you will be prompted if 
you wish to delete the highlighted song. 
Press ‘Yes’ to delete the file or ‘No’ to abort. 
 
New: Allows you to create a new song by 
deleting the currently loaded score, 
instruments, mixer settings and effects.  
 
Import: Allows you to import a midi file. Midi 
files are a standard file format used for 
storing musical scores and instrument control 
data.  
 

 
Importing Midi Files 
 
Audio Box allows you to import scores from other musical packages by means of 
a midi file import function. You can do this via the ‘Import’ button in the ‘Load 
Song’ file area. Midi files only contain score data, and not instrument sounds or 
settings.   
 
NOTE: Midi files are created with the intention of being played on midi 
compatible devices that have a GM (general midi) compatible sound cards or 
software synthesizers. Your Pocket PC is not equipped with the ability to play 
standard midi files as standard, nor does it have a MIDI compatible sound card. 
Therefore scores imported in this way will not sound as the creator intended, and 
some work is needed to configure the instruments after import. 
 
Pressing the ‘Import’ button displays a popup menu asking if you wish to ‘Import 
MIDI by channel’ or ‘Import MIDI by Track’. Once one of these options is selected 
you will be prompted for a file to import. 
 
‘Importing by channel’ is the likely choice as this ensures best compatibility 
with Audio Box. This is due to the fact that the midi standard has a total of 16 
midi channels, which maps nicely to Audio Box’s 16 channel mixer.  
 
‘Importing by track’ allows you to retain the track layout and track names but 
will be problematic if the file contains more than 16 tracks. Anything above track 
16 is discarded.  
 



After loading a midi file Audio Box automatically allocates instruments to each of 
the 16 channels. By default a classic synthesizer with default settings is assigned 
to all channels except channel 10, which is assigned the drum machine. This is 
because the midi standard usually maps channel 10 as drums. This makes 
perfect sense when importing by channel, but may need to be changed if 
importing by track.  
 
By default each synthesizer is set up in monophonic mode. You can change this 
if a track contains requires polyphony, but it is not recommended to do this for 
every channel. It is more CPU friendly to keep the synthesizers in monophonic 
mode if possible. If this causes problems then you may need to consider 
changing the audio output to 22Khz. Alternatively select a Pad Synthesizer 
instead of the Classic Synthesizer as it is better suited for the job. 
 
 

Preferences 
 
The Preferences are accessed via the ‘File’ tab and contains various program 
settings that can affect the way Audio Box performs. You can also check this 
screen to see if your CPU is under stress or if you feel you are running low on 
memory.  

 
By default Audio Box is set to output high 
quality 44Khz stereo audio. This is fine for 
most users providing your Pocket PC is fast 
enough to keep up with your demands.  
 
If you wish to use lots of effects or your song 
is very hungry in terms of polyphony you may 
need to change this to 22Khz. This will 
reduce the quality of output, but gives you 
twice the processing power.  
 
To change the sample rate you need to 
select the desired settings, 44Khz, 22Khz, 
Stereo etc. then press the ‘Apply Changes’ 
button. Please note that this will delete all 
song data in memory so please ensure you 
save your song before doing this. 
 

 
Bypass Effects: This option turns off all the effects assigned to each of the 16 
tracks. If a song is too processor intensive with effects it is handy to be able to 
turn them off. 
 



HQ Mode: This option is used to turn on high quality rendering of the sound by 
anti-aliasing the audio output of the synthesizers and sampler. Turning this option 
off should reduce the CPU load. 
 
Display Track Names: This option turns on and off the track names assigned in 
the track editor.  The screen can become a little littered at times, so it’s nice to 
clean up the display by turning this feature off. 
 
Master Volume: This allows you to control the Pocket PC’s volume control 
without leaving Audio Box.   
 
Master Tune: It may be useful to tune the output of Audio Box to other 
instruments. The master tune option allows you to fine tune the output by +/- one 
semitone. 
 
Metronome Volume: This controls the volume of the metronome. The 
metronome can be turned on or off from the OPTIONS button. 
 
Most of these preferences settings are saved between sessions. 
 
Tip: If the CPU meter is constantly peeking at 100% then you may want to 
consider changing to 22Khz mode or turning off HQ mode to reduce the load. 
 
 



Controller Messages 
 
Audio Box allows you to control various program settings in real-time as a song is 
playing. You can automate the mixing desk or adjust a synthesizer’s cut-off filter 
on the fly if you wish. You do this using controller messages. 
 
Pressing the ‘Controller Menu‘ button displays a list of devices that you can 
control. This consists of the Instrument attached to the selected channel, the 
Mixer settings for the channel, and the settings for selected effects 1-3. 
 

 
 
Selecting a device from the popup menu will then display a sub-menu of the 
parameters that can be automated. Select the desired controller and the 
controller area title will change accordingly. 
 
You now need to select the pencil tool from the ‘Edit Tools’ menu in order to draw 
controllers  Once selected you can draw into the controller area window using 
this tool. The following diagram shows the mixer pan controller messages of 
channel 3.  
 
NOTE: Some controller messages like pan and pitch bend use the centre of the 
controller window as a reference whilst others use the base of the window. 
 
Selecting the ‘Eraser’ tool from the ‘Edit Tools’ menu allows you to remove 
controllers from the graph area.  With the eraser selected simply draw over the 
area of the controller graph you wish to remove. 
 

Controller 
Menu 
Button 

Controller 
Area 



 
 
 
Deleting All Controllers 
 
At times you may wish to remove all controller massages from a track. This can 
be done quickly and easily by selecting the ‘Delete Controllers’ message from the 
‘Edit’ menu.  
 
Instrument Controllers 
 
The following list of parameters can be automated with both synthesizer and 
samplers:- 
 
VCO: Volume, Aftertouch, Pitch Bend, Portamento 
VCF: Resonance and Cut-off Frequency 
LFO: Vibrato, Tremolo and Wah-Wah 
 
Please Note: The LFO options only take effect if LFO is turned on for the 
selected instrument. Likewise, the VCF options are also only effective when the 
VCF is enabled. 
 
Cut, Copy and Pasting Controllers 
 
It is possible to copy and move blocks of controllers using cut, copy and paste. 
To do this you must have first selected the ‘Move’ tool from the ‘Edit Tools’ menu.  
 
To copy a block simply drag your stylus over the area you wish to copy then 
press the EDIT button and pick ‘Copy’ from the menu. Now place the location 
cursor you wish to place the copied data then select ‘Paste’.  
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To move a clock simply repeat the process using Cut and Paste. 
 

 



Audio Effects 
 
Audio Box allows you to add various effects to each of the 16 mixer channels. 
There are 7 different effects available for you to choose from, which are 
described below. 
 
1) Digital Delay: This effect is pretty self explanatory, and simply adds a delay or 
echo to the channel it is assigned to. Use this in preference to the reverb where 
possible as it is less of a load on the CPU. 
 
2) Digital Reverb: Adds reverberation to the selected channel. The reverb is a 
very fast form of delay which emulates the sound of large theatre halls or 
cathedrals. This effect is quite processor intensive. 
 
3) Chorus: Enhances a sound to give the impression of there being more than 
one sound source. This thickens up the sound giving an ensemble type effect. 
 
4) Phaser: This effect creates a rich sweep type effect by modifying the phase of 
the selected audio channel.  This effect is very processor intensive and so should 
be used sparingly. 
 
5) Distortion: Creates a simple distortion effect, useful for guitar sounds or 
creating lo-fi effects on vocals and drums. 
 
6) HP/LP Filter: This is a digital filter which is capable of removing certain 
frequencies above or below a specified cut-off frequency. This is similar to the 
cut-off frequency setting of the classic synthesizer, but has the added advantage 
of being able to be used on drum kits.  
 
7) Gapper: Used to create sounds associated with the trance genre of music. It 
works by cutting chunks out the sound giving the impression of playing fast 
sequences of notes in time with the tempo of the song.  If the speed setting is set 
to 4 you can select one of 4 pattern buttons to allow more interesting effects.  
Please note that this effect can only be heard whilst playing your composition as 
it syncs the gaps with the music using signals sent from the score editor when 
playback has started. You could set up a simple one bar loop to test this effect. 
 



Some audio effects can be controlled using controller messages sent from the 
score editor. The following effects are available for automation:- 

 
Effect Automation Features 

Digital Delay Decay 
Feedback 

Digital Reverb Brightness 
HP / LP Filter Resonance 

Cut-Off Frequency 
Phaser Feedback 

Depth 
Gapper Speed 

Delay 
Chorus Speed 

Width 
Depth 

 
For more information on automation of effects see the section of the manual 
concerning controller messages. 
 
Note: Adding too many audio effects will seriously overload the CPU and cause 
stuttering and break-up of sound. If you really need to use more than a couple of 
effects then you should consider switching to 22Khz mode. 
 



Quick Start Guide 
 

This section gives a basic outline of song construction and briefly looks at various 
elements of the user interface. Once you’ve read this section you should be 
confident enough to start constructing your own songs. 
 
Laying down a basic drum pattern: 
 
When Audio Box is launched you will be presented with the track editor screen. 
The track editor gives an overview of your whole song and allows you to copy 
and move chunks of your song from one location to another. The following steps 
show how to assign an instrument to a track and begin composing using the 
score editor. 
 
1) The first thing you need to do is select the track you wish to work with. The 
active track is the one with the RED bounding rectangle. You can change the 
active track by clicking on the track number or by using the UP and DOWN 
cursor keys. The diagram below shows the empty track editor. Track one has the 
RED rectangle and is therefore the active track. Notice the active track number is 
displayed in the top right of the information bar. 
 

 

 
 

 
2) The Voice, Mixer and Score tabs always display information about the active 
track. Click on the ‘Voice’ tab at the bottom of the screen to assign an instrument 
to the active track. The following instrument selection screen is displayed from 
which you should select the drum machine. 
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3) Now press the Track tab to return back to the track editor. We are now going 
to turn on loop mode and set loop points which will be used to cycle between a 
bar of our song whilst we add notes to our score. 
 

 
 
Press the ‘Loop’ button on the left of the navigation bar. Once active it should 
turn red. Now tap and hold the stylus on bar one of the timeline and whilst the 
stylus is in contact with the screen drag it to bar two. When you release the stylus 
you should see a grey area appear in the timeline with two inward facing arrows. 
This indicates that a loop is set between the two arrows. 
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4) Now press the ‘Play’ button on the navigation bar and ensure that the location 
cursor cycles between the two loop points. When the cursor hits bar two it should 
begin again at bar one. If all goes well then you are ready to start adding notes. 
 
5) At this point you may wish to turn on the metronome. To do this press the 
OPTIONS button and select the ‘Metronome’ option. You can always turn this 
feature of later if you find it undesirable. You can alter the metronome volume 
from the Preferences window located in the ‘File’ tab area. When enabled the 
metronome plays a soft sound every beat and a slightly louder sound every bar. 
This can be used to judge the tempo whilst editing your song. 
 
6) Click on the ‘Score’ tab at the bottom of the screen to switch to the score 
editor mode. This is where you enter note data for the active track. Taping the 
stylus on the piano roll allows you to hear the pitch of a note or in this case drum 
sound laid at that vertical position on the notation grid. 
 

 
 
7) Next we need to set the length of the notes we wish to lay on the notation grid. 
Click on the ‘Note Length / Duration’ option in the information bar. A menu will 
appear containing a list of fractional bar values. Select 1/8 from this list. 
 
8) Select the ‘Pen’ tool from the ‘Edit menu’ button. 
 
9) Finally tap the stylus on the screen to lay notes as in the above diagram. As 
you lay the notes you will hear them play as the location cursor cycles around the 
track. If you make a mistake don’t worry. You can move notes by simply selecting 
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the ‘Arrow’ tool from the ‘Edit Tools’ menu and drag the note to the required 
location. You can also remove notes using the ‘Eraser’ tool. 
 
NOTE: If you wish you can change the volume of any particular note by selecting 
the ‘Pen’ tool and drawing in the controller area beneath the notation grid. Each 
vertical bar represents a notes volume and the length of the bar represents it’s 
respective volume. The longer the length of the bar, the louder the note. 
 
If all has gone well you have now successfully laid your first bar of drums.  
 
Adding a Bass line: 
 
1) Change the active track to ‘2’ using the UP and DOWN arrow keys (or using 
the method described earlier in track mode)  
 
2) Press the ‘Voice’ tab and assign a ‘Classic Synthesizer’ to that track from the 
‘Device’ selection on the first sub-tab. 
 
3) Switch back to score mode and add the following bass line. 
 

This is just an example of how you can layer 
up your song, creating it one bar at a time. 
We could have set the loop points to span 
several bars, or chosen not to use loop points 
at all. 
 
You can customise the instruments or 
change the way they sound by clicking the 
‘Voice’ tab.  A set of sub-tabs will appear 
allowing you to change the parameters of the 
selected instrument. The Patch tab allows 
you to load some of the ready to use 
instrument patches, whilst Page 1-4 allow 
you to manually tweak the various 
instruments. 
 
 
 

 
Once you have several tracks of data you may wish to change their respective 
volumes. You can do this using the mixing desk, available on the ‘Mixer’ tab. The 
Mixer allows you to set the volume, pan and effects for each track. 
 
 
 
 



Troubleshooting 
 
This section is intended to help those who are having problems with Audio Box 
and is in the form of questions and answers. If you cannot find the answers here 
please contact us via our website. 
 

Question Answer 
I have entered some data in the score 
editor but I cannot hear any output 
when I press play. Why is this? 

1) You have not selected an instrument 
for that track. 
2) The mixer setting for that track is set 
too low. 
3) The Pocket PC’s volume control is 
turned down or muted. 

Why is the sound is distorted during the 
playback of my song? 

1) Try reducing the volume of all the 
tracks in the mixer, or lower the master 
mix slider. 
2) Reduce the level settings of the 
instrument causing the problem. 

Why is the sound breaking up and the 
screen update slowing to a crawl? 

1) You are playing a song which is 
playing back lots of notes at the same 
time. You need to reduce CPU load by 
doing one of the following: 
 

a) Disable the VCF and LFO on 
instruments where possible. 

b) Switch HQ mode off in 
Preferences. 

c) Switch to 22Khz mode. 
d) Reduce the number of effects or 

turn bypass effects on in 
Preferences. 

e) Use the pad synthesizer and 
sampler instead of the classic 
synthesizer where possible. 

Why does the samplers ‘Auto Tune’ not 
work on certain samples? 

This feature does not work well for 
certain types of sounds such as vocals, 
sound effects and drums etc. Also 
some sounds rich in harmonics make it 
difficult to detect the fundamental 
frequency. In this case you must resort 
to manual tuning. 

How do I adjust the song length? Select the ‘Song Finish’ option from the 
EDIT menu. 

Why is the Gapper effect not working? This effect only works when a score is 
being played. It synchronizes itself with 



the sequencer so it must be running to 
hear the effect. 

Why do MIDI files not play correctly? MIDI files are designed to work on 
equipment that have a general midi 
compliant sound card. The Pocket PC 
doesn’t have such a device. Audio Box 
imports only note on and off 
information as well as volumes, pitch 
bend and tempo. It is your 
responsibility to assign the correct 
instruments to watch track after an 
import.  
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